Using tables for organisation and display in Word

If you are a Microsoft Word user, it is likely that you will eventually have to create a table. This note shows you ways of working with tables to get the results you want. It assumes you know how to create tables, insert text, and select, add and delete rows and columns. If you are new to tables, see the note Tables in Word for the basics.

Turning the tables

There are two ways in which you can use Word’s table features. The most common is as a method of displaying data. The other is as a layout mechanism for arranging content on a page.

Using tables to display data

If you need to present information in rows and columns, then a table is the obvious choice. Even if it is only a few rows or columns, tables are easier to use than tabs, and less likely to go wrong.

Creating your table

The best option to use is Table – Insert – Table. Although the Draw Table option temptingly appears at the top of the menu, it isn’t the most practical or efficient method. (It does have its uses though – see the tip in the section on merging and splitting cells.) Make sure the AutoFit behavior option is set to Fixed column width and Auto so that you can control your column sizes yourself.

Formatting table text

Tables take on a default table style, whether you want it or not. You’ll see ‘Table grid’ in the Style box on the formatting toolbar: (A ‘style’ is predefined formatting that is applied to paragraphs or characters, and is fundamental to the way Word works. See the note Making your documents look good: using MS Word the easy way for information on styles and how to edit and create them.)

You can modify the Table Grid style or even create a custom table style (useful if you want all the tables in a document to look the same). You can also use any of Word’s other built-in styles, such as Heading 1, Heading 2, etc. Be careful with the heading styles however; if you create an automatic table of contents for your document that uses these styles, text from the table will appear in the contents list.

You can, of course, simply format table text manually by using the Formatting toolbar.

Note: You can apply any paragraph style to a table created with the Table Grid style ... apart from Normal! If you do want to use Normal, you can set this when you create the table. Click on the AutoFormat button at the Insert Table dialog box and select Table Normal. You will have to apply borders manually.
If you are using a table to present financial information, create your data in Excel then paste the cells as a Word table. You can get Excel to do your calculations, then format the table as you wish in Word. See the note *Working Together with Word, Excel and PowerPoint* for information.

**Positioning your table**

You can change where your table appears on the page. Select **Table – Table Properties**, click on the **Table** tab and choose the **Alignment** setting.

**Note:** Avoid dragging the table with the table move handle:

This places the table inside a hidden frame and turns it into a floating object which is not anchored, and can be difficult to work with.

**Sizing rows, columns and tables**

You can quickly resize columns and rows – simply move your cursor over the border until it becomes † or ‡, and drag to a new location. You can also drag the column markers on the ruler.

If you try to move a column a small amount you might find the change does not stick. Try holding down the **Alt** key while you drag; this allows you to move more precisely.

You don’t need to drag columns around for a perfect fit. To make a table fit the page, select **Table – Autofit – Autofit to Window**. The table will fit between the page margins (or column margins if the table is in a column). To make a table fit to its content, for example, a table nested in a table cell, select **Table – Autofit – Autofit to Content**.

**Autofit to Window** is a great solution if you have inserted new columns or pasted an Excel spreadsheet and your table has gone beyond the edge of the page. Once it’s back inside the margins, you can resize the columns to suit. Another method is to use the **Preferred width** option on the **Table** tab in the **Table Properties** dialog box. Set **Measure in** to **Percent** and enter the width.

If you are trying to make rows and columns equal sizes, don’t try to drag them; you will never get them exactly right. Instead, first select the rows or columns and use **Table – Autofit – Distribute Rows Evenly** or **Distribute Columns Evenly**.

To resize your entire table, move your cursor to the bottom right corner to display the table resize handle:

Click on the handle and drag. A dotted line shows the dimensions of the table as it is being resized. To resize proportionally, hold down **Shift** and drag. The table resizes rows and columns, but not the content; you may need to change the font size.

**Aligning content**

**Setting alignment**

You can control how your content looks in the table by aligning it horizontally and vertically within the table’s cells.

To align content horizontally, use paragraph alignment and paragraph indentation (select **Format – Paragraph** and click on the **Indents and Spacing** tab). If you are using the same settings over again, remember that you can create and apply a paragraph style rather than format text directly.

To align cells vertically, select **Table – Table Properties** and click on the **Cell** tab. Select from **Top**, **Center** or **Bottom**. To apply the same alignment to a row, column, or the entire table, make your selection first.
A quick way to align vertically and horizontally in one step is to use the alignment icon on the **Tables and Borders** toolbar:

---

**Setting tabs**

You can also use tabs to control positioning within cells. Make sure you can see the ruler (**View** – **Ruler**). Click in the cell where you want to insert the tab. Click the tab button at the left end of the ruler until it changes to the tab type you need and click on the ruler. To move to the tab, click in the cell and press **Ctrl** and **Tab**.

---

**Setting repeating heading rows**

If you have column headings, you will want these to repeat if your table flows onto a new page. To do this, click in the first row and select **Table** – **Heading Rows Repeat**. The heading will display on every page. If your heading is more than one row, select the rows (hold down **Shift** and click), then select **Table** – **Heading Rows Repeat**.

---

**Controlling page breaks**

If your table does flow over pages, it is useful to be able to control where it breaks. There are two aspects to this:

- In the table itself, you can prevent content within a row from breaking across pages. You can do this for individual rows, or for the entire table. Select the row, then choose **Table** – **Table Properties**, click on the **Row** tab and deselect **Allow row to break across pages**. For the entire table, select **Table** – **Select** – **Table first**.

- To force a page break at a particular place, without splitting the table (a must if you have repeating heading rows), click in the first cell of the row that is to move to a new page and select **Format** – **Paragraph**. Click on the **Line and Page Breaks** tab and select **Page break before**.

---

**Applying borders and shading**

If you are using the default table style, borders are applied to the whole table. You can change the borders and shading for rows, columns, or even individual cells by using the **Format** – **Borders and Shading** dialog box. Remember to look at the **Apply to** box to check you have made the correct selection.

When applying borders, there are a couple of points to watch out for:

- If you are using the default table styles, your first change to the border style, colour or width will take effect immediately. Once you have altered the borders, even if it is only for one cell anywhere in the table, you may have to deselect and reselect an existing border, or make a selection from the **Setting** panel, for further changes to take effect.

- Although you can apply borders and shading to the table or to selected cells, there is a difference between table and cell borders. If you set a border for the table, this will override cell borders if the table flows over a page. The top and bottom borders will repeat when the table splits across the page. This is the reason for borders appearing at page breaks even though they have been removed from the cells themselves.

As well as applying shading manually, you can also create an automatic striped pattern by modifying the table style. Click to open the **Styles and Formatting** task pane. Click the down arrow at the style name and click **Modify**. In the **Apply formatting to** box, select a stripe pattern. Click the arrow next to **Shading Color** and choose a colour for the stripes.
You can change the number of rows or columns in the pattern by selecting Format – Stripes from the Modify Style dialog box.

**Note:** You can only modify a table style in this way.

**Re-using your table**

It can take a significant effort to create and format a table. If you have created something you want to use again, you can save it as an AutoText entry.

To save your table structure, first delete the content and select Table – Select – Table. Next, select Insert – AutoText – New. Enter a name for your table and click OK.

To insert your table in a document, click Insert – AutoText. The categories Word uses to store entries are derived from the paragraph style in the first cell. If you have used a table style, your AutoText will be in one of the table categories; if not, it is likely to be in the Normal category. Locate your entry and select it. Your table structure appears in your document.

**Using tables to organise content**

If you need to organise information on a page, tables are much simpler to use than tabs or columns, particularly if you have a mixture of media. A table is essentially a container; it can help you to align text and images easily, and you can even nest one table inside another to handle complex layouts.

**Removing borders**

If you are using a table for placement, it is likely that you will not want a border round the cells. To create a table with no borders:

- Select Table – Insert – Table and choose the number of rows and columns.
- Click the Autoformat button.
- In the Table styles list, select Table Normal and click OK.

If you have already created the table, click in the table and select select Format – Borders and Shading. Make sure Apply to is set to Table and select None.

You can apply borders and shading to rows, columns and cells to create different effects. See the section Applying borders and shading above for more information.

**Controlling placement**

For more exact placement of items within a table, you can set alignment and margins for individual cells. Select the cells and choose Table – Table Properties then click on the Cell tab. Select the alignment option you need.

To change cell margins, click the Options button. Deselect Same as the whole table and set the value.

Remember that the table style may have been set with paragraph spacing before and after, which will affect placement. You can either modify the style or use Format – Paragraph to apply manual formatting.

**Merging and splitting cells**

You are not limited to using a table with uniform cells. You can merge and split cells to get the shapes you need. Select the cells then use Table – Merge Cells or Table – Split Cells.

Use this with caution, however – once cells have been merged or split, formatting can become difficult to manage (particularly inserting or deleting rows and columns), and your table can become unstable. Consider using nested tables instead (see below). If you want a merged heading over several columns, wait until you have completed resizing the columns before carrying out the merge.
Use **Table - Draw Table** (or the **Draw Table** icon on the **Tables and Borders** toolbar) to split cells exactly where you want. Drag the cursor over the area where you want the new cell to appear. You may need to zoom in to draw accurately.

**Using nested tables**

Nesting a table means creating one table inside another. Use this whenever you want content next to a table. For example, you might have a chart and want to show the data in a table beside it, as in the picture below.

To create your layout:

- Insert a table with as many rows and columns as you need. The example above has two rows (one for the headings) and two columns. This is your host table.
- Select **Table – Table Properties**. Click on the **Cell** tab and the **Options** button and set all cell margins to 0.
- Select **Table – AutoFit – AutoFit to Window**.
- Select **Table – Autofit – Fixed Column Width**. This stops Word from automatically resizing columns.
- Remove unwanted borders using **Format – Borders and Shading**.

You can now put anything you want into the host table. To create a table inside the host table, click in the cell and insert it. To make the nested table fit the cell exactly, use **Table – AutoFit – AutoFit to Window** (the cell is the nested table’s window).

If you want to add content to the host cell (as opposed to the nested table) click in the last cell in the nested table and press the **right arrow** key twice.

**Adding images**

Images can be 'inline' or 'floating'. An inline image is 'in line with text' and can be formatted the same way; for example, you can apply paragraph alignment and spacing to it. A floating image floats over text and can be picked up and moved independently of the text; the text can also be set to wrap around, above and below it. While floating graphics might seem an attractive option, they can be much harder to work with and can produce unpredictable results when you are editing the text. They can also cause problems in tables. If you do want text to wrap around your image, you can simulate the effect by placing the image in one cell and the text in cells around it.

To avoid problems, you should paste graphics into Word as **pictures** rather than **objects**. Select **Edit – Paste Special** and select the **Picture (Enhanced Metafile)** option for best results. Click on the image and select **Format – Picture**. Click on the **Layout** tab and make sure **Wrapping** is set to **In line with text**. The note **Working Together with Word, Excel and PowerPoint** provides advice on cutting and pasting between applications.